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Bài 1. Giới thiệu về ảnh số 

Mục tiêu của bài: Cung cấp những kiến thức cơ bản về ảnh số và các thông số cơ bản 

về ảnh số.  

1. Pixel ảnh bitmap và ảnh vectơ 

- Bitmap: Ảnh Bitmap là tập hợp các điểm ảnh tạo nên một hình ảnh có thể quan sát được. 

Số điểm ảnh càng nhiều thì hình ảnh càng rõ nét. Các hình ảnh Bitmap có tính phụ thuộc vào 

độ phân giải. Nghĩa là độ phân giải càng cao thì hình ảnh càng sắc nét. Mỗi hình ảnh Bitmap 

xác định sẽ chứa số lượng điểm ảnh xác định. 

- Vectơ: Đồ họa vector trong đồ họa máy tính sử dụng các tọa độ trong mặt phẳng 2 chiều 

để biểu diễn hình ảnh. Các tọa độ này sẽ góp phần tạo nên các path và các path này còn có thể 

có các thuộc tính như màu nét, hình dạng, độ dày,... Ảnh được tạo thành bằng kỹ thuật này 

được gọi là ảnh vector. Các định dạng ảnh vector phổ biến hiện nay bao gồm: SVG, EPS, 

PDF,... Vector sử dụng phần mềm chuyên dụng là Adobe Illustrator hoặc Corel. 

So sánh hình ảnh bitmap và vectơ: 

Hình Bitmap: 

 

Được tạo thành từ sự sắp xếp các điểm ảnh, gọi là pixels, theo kiểu lát gạch hay ô lưới. 

Ví dụ, hình chiếc lá bên cạnh được phóng lớn hiển thị những điểm màu pixel sắp xếp trên từng 

ô vuông, mỗi ô là 1 pixel. Hiệu chỉnh hình bitmap thực chất là hiệu chỉnh thuộc tính các pixels. 

Chất lượng ảnh Bitmap phụ thuộc vào độ phân giải của hình (đơn vị là ppi=pixels per 

inch), độ phân giải càng cao thì hình càng mịn và sắt nét nhưng sẽ nặng file và tốn tài nguyên 

máy. 

Khi tăng giảm kích thước ảnh bitmap sẽ gây ra hiện tượng "bể" hình: các cạnh bị răng 

cưa và màu sắc bị phân mảng ô vuông. Đó là khi số lượng pixel tăng lên, máy phải nội suy ra 

thuộc tính các pixels phát sinh. Vấn đề là máy tính chưa đủ thông minh để gán thuộc tính chính 

xác cho các pixel này, nên ảnh không liền lạc. 

Lợi thế của hình bitmap không phụ thuộc vào các giới hạn của vector là mức độ pha màu, 

là định dạng trong các ảnh chụp. 

Hình vector: 
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Được tạo thành từ các đường thẳng và đường cong toán học, gọi là vectors, bao gồm cả 

các thông số về màu sắc và vị trí của ảnh. Ví dụ như hình chiếc lá bên cạnh trong phần phóng 

to hiển thị các đỉnh và các đường tạo nên màu nét (stroke) và màu tô (fill). 

Hiệu chỉnh hình vector thực chất là hiệu chỉnh các thuộc tính của các đường vector tạo 

ảnh. Vì không phụ thuộc vào độ phân giải, nên chất lượng hình không ảnh hưởng khi tăng 

giảm kích thước. 

Lợi thế hình vector là các mảng hình học, nên thường dùng trong: 

 Hình ảnh cách điệu 

 Phân mảng bố cục 

 Văn bản để chữ luôn rõ nét. 

 Hoa văn trang trí 

 

 

 

2. Độ phân giải và kích thước ảnh 

Điểm ảnh là đơn vị có thể đo lường được. Chẳng hạn một máy ảnh DSLR có thể chụp 

tấm ảnh 5472 × 3648 pixel (20megapixel); hay một điện thoại có thể chụp ảnh kích thước 

4928x3264 (khoảng 16 megapixel). Bạn có thể kiểm tra kích thước này của hình ảnh bằng các 
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phần mềm, kiểm tra thông tin ảnh. Số lượng điểm ảnh cho ta biết độ phân giải ảnh, xác định 

kích thước màn hình tương ứng để xem toàn bộ tấm ảnh. 

 ppi (pixels per inch) là mật độ thông tin mà các màn hình có thể thu nhận trên mỗi inch 

 dpi - (dots per inch) là số điểm trên diện tích 01 inch vuông được tính trong in ấn. 

Cùng kích thước vật lý, độ phân giải cao tức là số lượng pixel nhiều và kích thước từng 

pixel sẽ nhỏ hơn là độ phân giải thấp tức là có ít pixel hơn và chúng lại có kích thước lớn hơn. 

Độ phân giải cao dù pixel nhỏ hơn nhưng nhiều sẽ cho chất lượng bản in mượt hơn, ảnh in độ 

phân giải thấp dù pixel có kích thước vật lý lớn hơn thì bản in bị vỡ nát. Chẳng hạn in khổ A4, 

ảnh có kích thước 300 x 400 thì vẫn đáp ứng được độ phân giải. Nhưng cũng với độ phân giải 

này, in offset khổ A3 hoặc A2 thì hình sẽ bị vỡ (không sắc nét). 

 Để có được một bản in (hình ảnh) đạt chất lượng, bạn cần chú ý đến độ phân giải ảnh 

(resolution) được tính bằng đơn vị dpi. dpi viết tắt bởi các từ dots per inch. Chỉ số dpi 

của ảnh cao thì đồng nghĩa bản in có chất lượng cao và dung lượng file ảnh cũng lớn. 

Độ phân giải 300 dpi nghĩa là trên 1 diện tích là 1 inch thì có 300 “ô vuông” nhỏ nhỏ. 

Hay độ phân giải 72 dpi là có 72 “ô vuông” trên 1 inch. 

 Độ phân giải tốt nhất là bao nhiêu dpi? Đối với hình ảnh in, độ phân giải lý tưởng 

là 300 dpi cho hình ảnh và 400 dpi cho văn bản ở kích thước in cuối cùng. Nếu tăng 

dpi lớn nhưng kích thước ảnh nhỏ hơn kích thước bản in mong muốn thì ảnh sẽ không 

đạt chất lượng. Do vậy, nên chọn file có kích thước bằng hoặc lớn hơn kích thước bản 

in dự định in. 
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3. Các hệ màu thông dụng 

Những màu sắc cơ bản 

 

Màu cơ bản là những kiến thức sơ đẳng nhất về hội họa mà những người mới theo con 

đường design cần phải biết. Nó là những màu sắc mà khi kết hợp với nhau theo những tỉ lệ 

nhất định sẽ tạo ra một màu mới nằm trong dải ánh sáng nhìn thấy. RGB và CMYK là 2 hệ 

màu có các hệ thống màu cơ bản khác nhau: RGB là 3 màu cơ bản của ánh sáng thông thường 

còn CMYK là hệ thống màu cơ bản dành cho ngành in ấn. Hãy tìm hiểu và so sánh về 2 hệ 

màu cơ bản này và xem chúng làm việc như thế nào. 

Hệ màu CMYK: 

CMYK là từ viết tắt tiếng Anh của cơ chế hệ màu trừ, thường được sử dụng trong in ấn. 

Nó bao gồm các màu sau: 

 C = Cyan (xanh) 

 M = Magenta (hồng) 

 Y = Yellow (vàng) 

 K = Black (Đen) (sở dĩ dùng từ K để chỉ màu đen vì ký tự B đã được dùng để chỉ màu 

Blue, ngoài ra K còn có nghĩa là Key, mang ý chỉ cái gì đó là chủ yếu, là then chốt) 
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Nguyên lý làm việc chính của hệ CMYK là hấp thụ ánh sáng. Màu mà ta nhìn thấy là từ 

phần của ánh sáng không bị hấp thụ, hay nói cách khác, chúng hoạt động trên cơ chế những 

vật không tự phát ra ánh sáng mà chỉ phản xạ ánh sáng từ các nguồn khác chiếu tới. 

Do đó thay vì thêm độ sáng để có những màu sắc khác nhau, CMYK sẽ loại trừ ánh sáng 

đi từ ánh sáng gốc là màu trắng để tạo ra các màu sắc khác. 3 màu Cyan, Magenta và Yellow 

khi kết hợp sẽ tạo ra một màu đen. 

Màu CMYK thường được sử dụng khi thiết kế phục vụ cho mục đích in ấn các thiết kế 

như poster, brochure, name card, catalogue, sách hoặc tạp chí,… 

Hệ màu RGB: 

RGB là từ viết tắt tiếng Anh của cơ chế hệ màu cộng, thường được sử dụng để hiển thị 

màu trên các màn hình TV, monitor máy tính và những thiết bị điện tử khác (chẳng hạn như 

camera kỹ thuật số). Nó bao gồm các màu sau: 

 

 R = Red (đỏ) 

 G = Green (xanh lá) 

 B = Blue (xanh dương) 
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Nguyên lý làm việc của hệ RGB là phát xạ ánh sáng, hay còn gọi là mô hình ánh sáng bổ 

sung (các màu được sinh ra từ 3 màu RGB sẽ sáng hơn các màu gốc)… Nếu CMYK là nơi bạn 

bắt đầu từ một tờ giấy trắng và sau đó thêm các màu khác, thì RGB hoạt động ngược lại. Ví 

dụ, khi màn hình TV tắt thì nó tối đen, khi bạn bật nó lên nó sẽ thành các màu đỏ, xanh lá cây, 

xanh dương, cộng thêm hiệu ứng tích lũy là màu trắng, để từ đó phát ra ánh sáng và hình ảnh. 

Mã màu RGB thường được sử dụng để thiết kế vật thể trên màn hình, máy tính, điện 

thoại, và các thiết bị điện tử khác... 
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Bài 2. Sử dụng phần mềm xử lý ảnh 

Mục tiêu của bài: Giới thiệu phần mềm xử lý ảnh, tính năng, cách sử dụng và các thao 

tác cơ bản với file ảnh.  

1. Cài đặt và khởi động 

- Phương pháp cài đặt chương trình Adobe Photoshop 

Bước 1: Tải bản cài đặt Photoshop 

Bước 2: Sau khi download Photoshop CS6 về máy, ta di chuyển tới chứa file để tiến hành 

cài đặt Photoshop. 

 

Chạy file Set-up.exe dưới quyền Administrator. 

 

Chờ một lúc để máy tính tiến hành cài đặt. 
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Bước 3: Ở bước tiếp theo chọn Install a trial nếu muốn cài đặt phiên bản dùng thử. Nếu 

có key thì ta chọn Install with a serial number hoặc Start my subscription. 

 

Bước 4: Tại đây hãy xác nhận điều khoản mà Adobe đưa ra. 
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Bước 5: Ta nên lựa chọn English là ngôn ngữ chính. Vì nếu chuyển sang tiếng Việt thì 

khó hiểu và khó tìm được hướng dẫn trên mạng. 

 

Bước 6: Photoshop sẽ tiến hành cài đặt, thông thường quãng thời gian này diễn ra khoảng 

5-7 phút. 
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Quá trình cài đặt hoàn tất. 

 

 

2. Các chức năng chính 

Giới thiệu giao diện chương trình Adobe Photoshop 

 

 Thanh Tiêu Đề: 

Chứa tiêu đề chương trình ứng dụng Adobe Photoshop. 

Chứa Ba Button chức năng: 

+ Close Button: Đóng chương trình ứng dụng. 

+ Restore Button: Phóng to/ Thu nhỏ cửa sổ chương trình. 
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+ Minimizes Button: Tạm thời ẩn cửa sổ chương trình ứng dụng lên thanh tác vụ. 

 

3. Thanh công cụ và các palette 

 Thanh Menu: 

Gồm có 9 Menu chức năng: 

+ Menu File: Chứa các chức năng liên quan đến thao tác trên tập tin: Mở mới tập tin, Mở 

tập tin có sẳn, Lưu tập tin, In ấn… 

+ Menu Edit: Chứa các chức năng liên quan đến việc hiệu chỉnh tập tin trong quá trình 

thao tác như: Trở về thao tác liền trước, thao tác liền sau. Sao chép, di chuyển nội dung vào 

vùng nhớ tạm, dán nội dung từ vùng nhớ tạm vào vùng ảnh… 

+ Menu Image: Chứa các lệnh về biên tập hình ảnh: Chế độ màu, Quay hình ảnh… 

+ Menu Layer: Chứa các chức năng xử lý lớp. 

+ Menu Select: Chứa các chức năng liên quan đến thao tác chọn và thôi chọn hình ảnh, 

biến đổi vùng chọn. 

+ Menu Filter: Chứa các chức năng tạo hiệu ứng trên ảnh. 

+ Menu View: Chứa các chức năng xác lập chế độ hiện thị hình ảnh. 

+ Menu Window: Chứa các chức năng hiển thị hay ẩn các Palette của chương trình. 

+ Menu Help: Chứa các thông tin trợ giúp sử dụng chương trình Adobe Photoshop. 

 Palettets Chức năng: 

Photoshop thể hiện chức năng thông qua giao tiếp trên Palette. Mỗi bảng Palette sẽ chứa 

các chức năng riêng của palette đó, nó giống như là một hộp thoại. Gồm có các Palette sau: 

+ Palette Navigator: Giúp trượt hình ảnh và điều chỉnh tỉ lệ 

hiển thị của hình ảnh. 

+ Palette Info: Cho biết thông tin màu tại vị trí con trỏ cũng như các thông tin khác tùy 

thuộc vào công cụ được chọn. 

+ Palette Layer: Quản lý lớp của đối tượng. 

+ Palette Style: Chứa các mẫu Style của lớp. 

+ Palette Chanel: Giúp quản lí Kênh màu 
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+ Palette Action: Giúp tạo và quản lí các thao tác tự động. 

+ Palette Color/ Swatches: Dùng để chọn màu. 

+ Palette Path: Quản lí đường biên. 

+ Palette History: Lưu các ảnh chụp nhanh và các trạng thái hiệu chỉnh ảnh. 

 Thanh tùy chọn: 

Chứa đựng các tùy chọn chức năng của công cụ được chọn trong hộp công cụ. 

 Thanh Trạng Thái: 

Hiện thị một số thông tin liên quan đến việc thao tác và tạo đối tượng trên ván vẽ. 

 Ván Vẽ: 

Ván vẽ là một cửa sổ làm việc được giới hạn bởi kích thước chiều dài và chiều rộng của 

hình ảnh. Là nơi tạo và hiệu chỉnh hình ảnh. Ván vẽ có thể được thay đổi màu nền thông qua 

chức năng Background. Bản chất ván vẽ cũng giống như một cửa sổ tài liệu. Trên ván vẽ cũng 

có ba Button chức năng giống như thanh tiêu đề và cũng có tiêu đề của tài liệu đang mở. 

 
  



Trang 16 

 

Bài 3. Thanh công cụ Tool Box vẽ hình 

Mục tiêu của bài: Giới thiệu các công cụ để vẽ đường, hình.  

1. Nhóm công cụ vẽ điểm, vẽ đường, vẽ hình 

Pen Tool * ( P ) 

Công cụ Pen Tool dùng để vẽ các đường path cực kỳ chính xác dưới dạng vector hoặc 

các vùng lựa chọn. 

Freeform Pen Tool ( P ) 

Công cụ Freeform Pen để vẽ các đường path hoặc hình shape dạng tự do. Điểm neo được 

tự động thêm vào đường dẫn khi bạn vẽ. 

Add Anchor Point Tool 

Thêm điểm neo vào path hoặc shape 

Delete Anchor Point Tool 

Công cụ xoá điểm nối, hay điểm neo (Anchor Point). 

Convert Point Tool 

Công cụ chuyển đổi điểm neo, giúp làm mượt hoặc chỉnh sửa các góc bo khi dùng 

Pentool. 

Path Selection Tool * ( A ) 

Sử dụng công cụ Path Selection Tool (mũi tên màu đen) trong Photoshop để chọn và di 

chuyển toàn bộ Shape. 

Direct Selection Tool ( A ) 

Sử dụng công cụ Direct Selection Tool (mũi tên màu trắng) để chọn và di chuyển các 

điểm của hình (hình ở đây Shape). 
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Rectangle Tool * ( U ) 

Công cụ Rectangle Tool giúp vẽ hình chữ nhật hình chữ nhật. Nhấn và giữ phím Shift 

khi kéo để chuyển thành hình vuông. 

Rounded Rectangle Tool ( U ) 

Công cụ Rounded Rectangle Tool tương tự như công cụ Rectangle Tool nhưng các cạnh 

được bo tròn. Nhấn và giữ phím Shift để vẽ hình vuông có góc tròn. 

Ellipse Tool ( U ) 

Công cụ Ellipse Tool giúp vẽ hình elip dưới dạng vector hoặc dạng pixel. Nhấn và giữ 

phím Shift khi kéo để vẽ thành hình tròn. 

Polygon Tool ( U ) 

Công cụ Polygon giúp vẽ các hình đa giác, có thể điều chỉnh được số cạnh. 

Line Tool ( U ) 

Công cụ vẽ đường thẳng trong Photoshop. 

Công cụ Custom Shape Tool ( U ) 

Công cụ Custom Shape Tool cho phép lựa chọn và vẽ hình dạng tùy chỉnh có sẵn trong 

thư viện của photoshop. 

 

2. Nhóm công cụ đặt màu, chế độ làm việc 
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Nhóm chế độ màu chuyển đổi Mode trong Menu Image 

Khi mở file ảnh cần chỉnh sửa, vào Menu Image chọn Mode bạn sẽ thấy các chế độ màu 

tổng hợp như sau (các dạng thường sử dụng): 

GrayScale: Chuyển ảnh sang màu trắng đen. 

Indexed Color:  Cho hình ảnh dạng kết hợp màu. 

RGB Color: Chế độ ảnh tổng hợp 3 màu chuẩn RGB, Đỏ (R) Xanh lá cây (G) và Xanh 

da trời (B). RGB là không gian màu dương tính thường được sử dụng phổ biến vì nó rất thuận 

lợi trong việc chỉnh sửa. 

CMYK Color: Chế độ ảnh tổng hợp 4 màu chuẩn. Là sự phối hợp giữa Cyan (da trời) 

Magenta (tím) Yellow (vàng) và blacK (đen). CMYK là không gian màu âm tính thường được 

sử dụng trong Lap in ấn. 

Lab Color: Chỉnh ảnh theo phương thức chụp, là không gian màu độc lập và chỉnh sửa 

màu trong hệ màu trền kềnh a hoặc kềnh b cũng như tạo ra những thay đổi mạnh mẽ nhất về 

màu sắc. Lab là hệ màu rất thích hợp trong chỉnh sửa ảnh KTS. 

3. Công cụ tạo ghi chú 

Nhờ Notes, bạn có thể thêm nhận xét, lời nhắc hoặc hướng dẫn cho cộng tác viên hoặc 

thậm chí cho chính bạn. Bạn có thể thay đổi, sửa đổi hoặc thậm chí xóa chúng bất cứ lúc nào 

bạn muốn. Hãy thêm Note đầu tiên của bạn vào một hình ảnh mẫu: 

Chọn công cụ Note từ hộp công cụ ở bên trái. Nó là một phần của bộ công cụ Eyedropper. 
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Trong thanh Option trên đầu trang, thêm tên của bạn vào trường Author và 

chọn Color cho Note. 
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Nhấp vào vị trí trong hình ảnh nơi bạn muốn đặt ghi chú. Con trỏ Note bổ sung thêm điểm 

đánh dấu ghi chú. 

 
 

Bảng Note sẽ tự động hiển thị. Đây là vị trí trung tâm để thêm nhận xét của bạn vào tất 

cả các ghi chú được thêm vào hình ảnh. 

4. Phóng to, thu nhỏ 

Công cụ Zoom * (Z) 

Nhấp vào hình ảnh bằng công cụ Zoom Tool để phóng to một khu vực cụ thể. Nhấn và 

giữ Alt (Win) / Option (Mac) và nhấp chuột bằng công cụ Zoom Tool để thu nhỏ. 
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5. Cắt xén 

Crop Tool * ( C ) 

Cho phép cắt hình ảnh với một khung (hình chữ nhật) lựa chọn tùy ý. 

Perspective Crop Tool ( C ) 

Cho phép cắt hình ảnh với một khung hình tùy chỉnh, giúp cắt một hình 3D thành phẳng 

2D. 

Slice Tool ( C ) 

Công cụ Slice chia một hình ảnh thành các phần nhỏ hơn và xuất ra thành từng ảnh khác 

nhau. 

Slice Select Tool ( C ) 

Dùng để chọn các thành phần được tạo bằng Công cụ Slice. 
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Bài 4. Thanh công cụ ToolBox sửa hình 

Mục tiêu của bài: Giới thiệu các thành phần trên thanh công cụ để sửa hình. Cần phân 

biệt được nhóm các công cụ.  

1. Sửa vết bẩn 

Spot Healing Brush Tool * ( J ) 

Giúp loại bỏ nhược điểm và các khu vực có vấn đề nhỏ khác trong một hình ảnh như 

mụn, nốt ruồi, vết bẩn nhỏ… 

Healing Brush Tool ( J ) 

Giữ Alt (Win) / Option (Mac) và nhấp chuột để lấy mẫu vùng ảnh tốt, thả phím và nhân 

tiếp lên vùng ảnh có khuyết điểm để lấp. 

Patch Tool ( J ) 

Với công cụ Patch, chúng ta vẽ một đường viền lựa chọn xung quanh vùng ảnh có vấn 

đề. Sau đó, fix nó bằng cách kéo sang một vùng ảnh đẹp tương tự để hoán đổi. 

Content-Aware Move Tool ( J ) 

Công cụ này rất bá đạo, dùng để chọn và di chuyển một đối tượng trên bức ảnh sang khu 

vực khác. 

 

2. Làm mờ, làm tối, làm sáng 

Blur Tool * 

Công cụ Blur làm mờ và làm mềm các vùng được tô. 

Sharpen Tool 

Công cụ Sharpen làm sắc nét các vùng được tô. 
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Smudge Tool 

Giống như hành động miết ngón tay qua vùng sơn ướt. 

Công cụ Dodge * (O) 

Làm sáng vùng ảnh được tô. 

Burn Tool ( O ) 

Công cụ Burn sẽ làm tối các vùng được tô. 

Sponge Tool ( O ) 

Giảm độ bão hòa màu sắc. 

 

3. Hộp mầu 

 

Khi click vào hình vuông foreground hoặc background, một bảng chọn Color Picker sẽ 

được mở. Ở đây,các bạn có thể chọn màu bằng cách di chuyển dấu tròn trong vùng màu. Chúng 
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ta sẽ dễ dàng thấy thông tin của màu đó ở bên phải như giá trị RGB,HSB,CMYK…Để ý đến 

giá trị cuối cùng bên dưới, có dấu # ở đầu, đây chính là mã màu. Mỗi màu khác nhau có một 

mã màu khác nhau. Thông số này sẽ được sử dụng rất nhiều,cả trong đồ họa và lập trình. 

 

4. Di chuyển 

Công cụ di chuyển * (V) 

Công cụ di chuyển được sử dụng để lựa chọn và di chuyển các đối tượng. 
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Bài 5. Thanh công cụ ToolBox chỉnh màu 

Mục tiêu của bài: Giới thiệu các thành phần trên thanh công cụ để chỉnh màu. Cần 

phân biệt được nhóm các công cụ.  

1. Nhóm công cụ chọn màu 

Hộp thoại Color picker là một công cụ chọn màu tuyệt vời bởi vì nó cho bạn xem phổ 

màu nhằm giúp dễ dàng cô lập sắc màu, độ bão hòa và đôn sáng của màu mà bạn muốn sử 

dụng. Ngoài việc chọn màu. Bạn cũng có thể xem trước các màu bằng sắt màu (hue), độ bão 

hòa (saturation), độ sáng (bdightness), các phổ màu đỏ, xanh lục hoặc xanh dương hoặc bằng 

một web palette giới hạn; nhấp các giá trị HSB, RGB, CNYK và Hexadecimal chính xác; và 

chuyển đổi giữa việc xem một phổ màu và các Swatch xuất hiện trong Panel Swatch của tài 

liệu.  

Xem Color picker trong hình dưới để làm quen với tất cả xác lập. Để mở và sử dụng 

Color picker, nhấp đôi các biểu tượng Stroke hoặc fill trong Panel Tools hoặc trên Color. 

 

2. Nhóm công cụ đặt màu 

Công cụ Gradient * (G) 

Công cụ Gradient dùng để vẽ hòa trộn dần dần giữa nhiều màu sắc, hay màu chuyển. 

Paint Bucket Tool ( G ) 

Công cụ đổ màu 

https://1.bp.blogspot.com/-76txr5XhkYw/V1pjO8nyw-I/AAAAAAAABtE/xpXIogfE0UgcSjCfdva69YTaWGdzSdkzwCLcB/s1600/Color+picker.png
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3. Lấy mẫu 

Eyedropper Tool * ( I ) 

Công cụ Eyedropper của Photoshop lấy mẫu thông số màu trong một hình ảnh. 

Color Sampler Tool ( I ) 

Công cụ lấy mẫu màu cho từng điểm vị trí trong ảnh. 

 

4. Hộp màu Force Ground 

Quan sát trên hộp công cụ ta sẽ thấy có biểu tượng hai ô màu, ô nằm trên là ô màu 

Foreground (tiền cảnh) và ô nằm dưới là ô màu Background (hậu cảnh). 

 

 Foreground: màu tiền cảnh 

 Switch foreground to background colors: hoán đổi giữa màu tiền cảnh và màu nền (X) 

 Background: màu hậu cảnh (nền) 

 Default color: tái lập mặc định màu đen trắng (D) 

Tô màu cho vùng chọn bằng màu Foreground: nhấn phím Alt + Del. 

Tô màu cho vùng chọn bằng màu Background: nhấn phím Ctrl + Del. 
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Bài 6. Thao tác với tệp ảnh và vùng 

Mục tiêu của bài: Sử dụng các công cụ được cung cấp để mở, sửa, ghi một file ảnh. 

Biết cách thao tác với vùng trên ảnh.  

1. Mở, đóng và lưu file ảnh 

Cách mở file trong Photoshop 

 

Để mở file, từ thanh menu bạn vào File -> Open (Phím tắt Ctrl+O), sau đó tìm đến thư 

mục chứa file bạn muốn mở. Photoshop hỗ trợ tất cả các định dạng ảnh phổ biến như JPG, 

PNG, GIF. Ngoài ra còn có một số định dạng bạn ít nghe tới như RAW, SVG, TIF… 

Bạn cũng có thể sử dụng cách kéo thả file trực tiếp vào photoshop, bạn có thể nhìn hình 

minh họa dưới đây. 

 Nếu kéo file vào một tab đang mở, file sẽ tạo thành một layer mới trong tab đang mở. 

 Nếu kéo file vào khu vực trống trên danh sách tab đang mở, sẽ tạo thành một file mới. 

Cách tạo file trong Photoshop 

Để tạo một file mới bạn vào File -> New (Phím tắt Ctrl+N), một hộp công cụ sẽ hiện ra 

cho phép các bạn tùy chỉnh thông số. 

 
 

Cách lưu file trong Photoshop 

Photoshop có hai chế độ lưu file chính: 

http://piodio.com/wp-content/uploads/2017/06/Tao-file-moi-trong-photoshop-piodio.jpg
http://piodio.com/wp-content/uploads/2017/06/Tao-file-moi-trong-photoshop-piodio.jpg
http://piodio.com/wp-content/uploads/2017/06/cach-mo-file-trong-photoshop.jpg
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 Lưu theo cách thông thường (Save/ Save as) 

 Lưu tối ưu cho hiển thị trên website (Save for web) 

Save/ Save as 

Để lưu file bạn vào File -> Save hoặc Save As. Một hộp công cụ hiện ra cho phép bạn 

chọn nơi lưu file, định dạng file. Có khá nhiều định dạng để bạn lựa chọn, bạn có thể lưu dưới 

dạng PSD cho phép chỉnh sửa lại sau này, hoặc lưu dưới dạng file ảnh JPG, PNG, GIF…  Khi 

ấn Save một hộp Option sẽ hiện ra cho phép bạn tùy chọn chất lượng file, bạn cũng có thể xem 

trước kích thước file được tạo ở đây. 

 
 

2. Hiển thị ảnh trong nhiều cửa sổ 

Khi chúng ta mở nhiều hình ảnh, Photoshop sẽ hiển thị ảnh dưới dạng các tab. 

Theo mặc định, dù đã mở bao nhiêu bức ảnh đi nữa thì Photoshop cũng chỉ hiển thị một 

hình ảnh trong vùng làm việc. 

http://piodio.com/wp-content/uploads/2017/06/Luu-file-trong-Photoshop.jpg
http://piodio.com/wp-content/uploads/2017/06/Luu-file-trong-Photoshop.jpg
http://piodio.com/wp-content/uploads/2017/06/Luu-file-trong-Photoshop.jpg
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Mặc định, photoshop chỉ hiển thị 1 ảnh 

Chúng ta có thể sử dụng phím CTRL + TAB để chuyển đổi giữa các tab hình ảnh. 

Tuy nhiên, đôi lúc chúng ta vẫn cần hiển thị đồng thời nhiều ảnh một lúc để so sánh màu 

sắc hay chỉnh sửa. 

Vào Window -> Arrange -> Tile All Vertically. để hiển thị toàn bộ các hình ảnh đã mở 

dưới dạng cột. 

 

3. Giới thiệu định nghĩa vùng 

Trong photoshop layer được hiển thị là vùng được gạch nối tiếp nhau bằng phần đường 

gạch đen trắng xen kẽ nhau. 
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4. Lựa chọn vùng bằng các công cụ 

 Với Regular marquee tool(phím tắt M) với phím tắt M bạn có thể dễ dàng tạo ra vùng 

chọn hình chữ nhật, hình elip. Hoặc là hình vuông và hình chữ nhật nếu bạn là một 

người khéo tay. 

 

 Tạo vùng chọn bằng kéo thả chuột với Laso tool(phím tắt L). Laso tool sẽ là một công 

cụ hữu hiệu giúp bạn tạo vùng chọn theo ý của mình bằng cách kéo thả chuột ngoài ra, 

trong phím tắt L còn hỗ trợ 2 công cụ tạo vùng chọn rất tuyệt vời. 

 

 Quickselection tool và Magic want tool (phím W). Với 2 công cụ đặc thù giúp chọn 

vùng chọn theo màu sắc này, sẽ giúp bạn chọn những mãng li ti dễ dàng hơn và quét 

những vùng rộng cũng nhanh chóng hơn. 
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Bài 7. Lựa chọn vùng và thao tác với vùng 

Mục tiêu của bài: Sử dụng thành thạo các công cụ để thao tác với vùng trên ảnh.  

1. Bộ công cụ chọn vùng 

 Công cụ Rectangular Marquee * (M) 

Giúp khoanh vùng chọn hình chữ nhật. Nhấn và giữ phím Shift khi kéo để vẽ vùng chọn 

hình vuông. 

 Công cụ Elliptical Marquee Tool (M) 

Giúp khoanh vùng chọn hình elip. Nhấn và giữ Shift để vẽ vùng chọn hình tròn. 

 Công cụ Single Row Marquee Tool 

Công cụ Single Row Marquee Tool trong Photoshop giúp vẽ vùng chọn một hàng 1px từ 

trái qua phải 

Công cụ Single Column Marquee Tool 

Công cụ Single Column Marquee để vẽ vùng chọn một cột 1px pixel từ trên xuống dưới. 

 Công cụ Lasso * (L) 

Với công cụ Lasso Tool , chúng ta có thể tự do vẽ vùng lựa chọn bằng chuột. 

 Polygonal Lasso Tool ( L ) 

Khoanh vùng lựa chọn bằng các đường thẳng để tạo thành hình đa giác. 

Magnetic Lasso Tool ( L ) 

Công cụ tự động bám dính để tạo vùng chọn khi di chuyển chuột quanh đối tượng cần 

tách. 
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Quick Selection Tool * ( W ) 

Công cụ tạo vùng lựa chọn nhanh, chỉ cần nhấp chuột vào đối tượng thì Photoshop sẽ tự 

động tạo vùng chọn. 

Công cụ Magic Wand (W) 

Công cụ chọn các vùng có màu sắc giống nhau. 

 

2. Các tuỳ chọn của công cụ tạo vùng 

Để chọn Quick Selection Tool. Bạn nhấn vào biểu tượng của nó trong bảng Tools của 

Photoshop. Hoặc nhấn chữ W trên bàn phím để chọn nó bằng phím tắt. 

 

Sử dụng Quick Selection 

Để bắt đầu sử dụng quick seelectiong cho lựa lựa chọn của tôi. Tôi sẽ di chuyển con trỏ 

của Công cụ chọn nhanh vào góc trên cùng bên trái của áo len của đứa trẻ. Và tôi sẽ nhấp một 

lần bằng con chuột của tôi. Đường viền lựa chọn ban đầu xuất hiện xung quanh khu vực tôi đã 

nhấp vào. 
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3. Hiệu chỉnh vùng chọn 

 

Để thêm vào vùng chọn ban đầu của tôi. Tôi sẽ chỉ cần sử dụng Quick Selection tool nhấp 

và kéo dọc theo cạnh trái của áo len. Khu vực tôi kéo qua được thêm vào vùng chọn. Miễn là 

tôi giữ con trỏ bên trong áo len và không kéo trên bầu trời hoặc cây trong nền. chỉ có chính 

chiếc áo len được thêm vào: 

 

Sau đó chúng ta sẽ tiếp tục sử dụng quick selection. Thực hiện  kéo và mở rộng vùng 

chọn của mình ra sao cho phù hợp với mục đích ban đầu. Nếu bạn lỡ kéo quá ra bên ngoài bạn 

có thể ấn ctrl + Z. 

Bớt vùng chọn: 

Nếu bạn muốn bỏ bớt vùng nào đó khi bạn lỡ tay thêm quá nhiều thì sao. Với  Quick 

Selection tool trong photoshop. Công cụ chọn nhanh đã thực hiện một công việc ấn tượng. Với 

lựa chọn ban đầu của chủ đề chính của tôi, nhưng nó không hoàn hảo. Có một vài khu vực ở 

đây và ở đó cần phải được loại bỏ khỏi sự lựa chọn; như khoảng cách giữa áo len và cánh tay 

của đứa trẻ nơi nền được hiển thị thông qua: 

 

Để xóa một vùng khỏi vùng chọn, giữ phím Alt (Win) / Option (Mac). Tạm thời chuyển 

Công cụ Chọn nhanh thành Trừ; từ chế độ chọn (bạn cũng có thể chọn tùy chọn “Trừ từ lựa 

chọn”. trong Thanh Tùy chọn nhưng bạn cần phải nhớ chuyển nó về chế độ “Thêm vào lựa 

chọn” khi bạn hoàn tất) 
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Bài 8. Các lệnh làm việc với vùng 

Mục tiêu của bài: Sử dụng thành thạo các lệnh để thao tác với vùng trên ảnh.  

1. Các lệnh tạo vùng chọn 

Các tùy chọn lựa chọn sau đây được coi là thay đổi cơ bản: 

 Thêm vào lựa chọn (giữ phím Shift trong khi sử dụng các công cụ sau: Magic Wand, 

công cụ Lasso, công cụ Marquee) 

 Trừ từ lựa chọn (giữ phím Alt / Option trong khi sử dụng các công cụ sau: Magic Wand, 

công cụ Lasso, công cụ Marquee) 

 Intersect lựa chọn (giữ phím Alt / Option và Shift cùng nhau để cắt một lựa chọn mới 

với một trước đó) 

 Chọn tất cả (Ctrl / Cmd + A để chọn toàn bộ khung) 

 Bỏ chọn (Ctrl / Cmd + D để bỏ chọn tất cả mọi thứ) 

 Chọn lại (Ctrl / Cmd + Shift + D để chọn lại lựa chọn trước) 

 Đảo ngược lựa chọn (Ctrl / Cmd + I để bỏ chọn những gì đã được chọn trước đó và 

chọn những gì đã không được chọn) 

 Di chuyển lựa chọn (giữ phím Space khi vẫn vẽ vùng chọn bằng công cụ Marquee để 

di chuyển nó xung quanh) 

 Perfect vòng tròn hoặc vuông (giữ phím Shift với Elliptical hoặc Rectangular Marquee 

công cụ khi tạo ra chúng) 

 Vẽ lựa chọn từ trung tâm (giữ phím Alt / Option với công cụ Elliptical hoặc Rectangular 

Marquee khi tạo ra chúng) 

 

Thêm vào lựa chọn 
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Trừ từ lựa chọn 

 

Intersect lựa chọn 

 

2. Biến đổi vùng chọn 

Tính năng này về cơ bản là công cụ, mà sẽ chỉ chuyển đổi lựa chọn của bạn, nhưng không 

phải là nội dung của lớp chọn (s) Free Transform. Điều này có thể rất hữu ích khi bạn cần để 

tạo ra sự bóp méo điểm hình dạng được lựa chọn với các công cụ Marquee. Điều này có thể 

đạt được bằng cách giữ phím Ctrl / Cmd khi kéo một trong những điểm kiểm soát của hộp 

chuyển đổi bounding. Bạn cũng có thể sử dụng tính năng Warp để bẻ cong và định hình lại các 

lựa chọn của bạn với tính năng này. 
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Biến đổi các lựa chọn 

 

Lựa chọn Warp 

 

3. Lưu xác lập vùng chọn 

Tiết kiệm lựa chọn của bạn có thể hữu ích nếu bạn cần phải trở lại để chúng vào một ngày 

sau đó. Lựa chọn lưu được lưu trữ như kênh. Họ là về cơ bản Mặt nạ Pixel không giao cho bất 

kỳ lớp nào. Bạn có thể tìm thấy các tùy chọn dưới menu Select. 
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Lưu các lựa chọn 

 

Đặt tên cho các lựa chọn lưu 

 

4. Chỉnh sửa màu và biên vùng chọn 

Tính năng này sẽ làm mềm các cạnh lựa chọn của bạn. Kích thước điểm ảnh của lông sẽ 

xác định kích thước của làm mềm dần xung quanh các cạnh của lựa chọn của bạn. Bạn có thể 

gán một Feather vào các công cụ lựa chọn của bạn (Marquee và Lasso công cụ) hoặc thêm nó 

vào bất kỳ lựa chọn tạo ra từ menu Select. 
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Thêm Feather từ menu select 
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Bài 9. Hiệu chỉnh hình thái ảnh 

Mục tiêu của bài: Sử dụng các kiến thức đã được cung cấp về hệ màu, thao tác với 

vùng chọn để giải quyết bài toán hiệu chỉnh ảnh. Nắm vững các khả năng phục hồi tình 

trạng ảnh.  

1. Hiệu chỉnh kích thước hình ảnh 

Bước 1: Để chỉnh kích thước ảnh trong Photoshop, các bạn cần nhập ảnh vào trong phần 

mềm. Click chọn File >Open để mở trình tìm kiếm và nhập ảnh vào trong Photoshop. 

 

Bước 2: Sau khi đã đưa ảnh vào trong Photoshop, bạn click chọn Image >Image Size. Để 

kích hoạt nhanh chức năng Image Size, Taimienphi.vn khuyên bạn nên sử dụng phím tắt 

Photoshop (Ctrl + Alt + I). Nên nhớ sử dụng phím tắt Photoshop thường xuyên để tối ưu cách 

dùng với Photoshop nhé. 

 

Bước 3: Trong cửa sổ Image Size, các bạn chỉ cần nhập kích thước mà bạn muốn chuyển 

đổi vào trong hai mục Width và Height tại hai mục Pixel Dimesions hoặc Document size. 
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2. Hiệu chỉnh Canvas 

+ Bước 1: Bạn mở file ảnh mà bạn muốn chỉnh sửa và thay đổi kích thước ra bằng cách 

chọn File => chọn tiếp Open => chọn hình ảnh. 

 

+ Bước 2: Tại thanh Menu bạn chọn Image => chọn tiếp tính năng Canvas Size. Hoặc 

bạn có thể sử dụng tổ hợp phím tắt đó là Alt + Ctrl + C để bật tính năng mở rộng khuôn hình 

có sẵn. 
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+ Bước 3: Ở cửa sổ Canvas Size có ba điểm bạn nên lưu ý đó là: 

 Current Size: Bao gồm kích thước ảnh Width (chiều ngang), và Height (chiều cao) gốc 

của Layers ảnh. 

 New Size: Kích thước ảnh Width (chiều ngang), và Height (chiều cao) có thể thay đổi 

của Layers ảnh. 

 Anchor (mỏ neo): Để thay đổi kích thước ảnh về hướng bạn muốn, như hình. 

 

3. Xoay và lật hình ảnh 

Biến đổi ảnh bằng công cụ Transform 

Thay đổi kích thước, xoay trái xoay phải, lấy đối xứng ảnh… là những thao tác ta hay 

phải thực hiện trong Photoshop. Sau khi chọn Layer muốn thao tác, từ Menu ta chọn Image -

> Free Transform (phím tắt là Ctrl + T). Lúc này một hình chữ nhật sẽ bao quanh Layer, ta có 

thể thao tác kéo các góc để phóng to, thu nhỏ hoặc xoay trái xoay phải theo ý muốn. 
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4. Xén ảnh 

Crop Tool * ( C ) 

Cho phép cắt hình ảnh với một khung (hình chữ nhật) lựa chọn tùy ý. 

Perspective Crop Tool ( C ) 

Cho phép cắt hình ảnh với một khung hình tùy chỉnh, giúp cắt một hình 3D thành phẳng 

2D. 

Slice Tool ( C ) 

Công cụ Slice chia một hình ảnh thành các phần nhỏ hơn và xuất ra thành từng ảnh khác 

nhau. 

Slice Select Tool ( C ) 

Dùng để chọn các thành phần được tạo bằng Công cụ Slice. 

 

5. Phục hồi trạng thái của ảnh. Các tuỳ chọn của phục hồi trạng thái hình ảnh 

History Brush Tool * ( Y ) 

Công cụ này dùng để Undo một phần của bức ảnh về trạng thái trước khi chỉnh sửa. 

Art History Brush Tool ( Y ) 

Art History Brush Tool cũng giúp undo một phần bức ảnh về trạng thái trước đó, nhưng 

sử dụng các nét vẽ kiểu cách điệu. 
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Bài 10. Hiệu chỉnh màu sắc của ảnh 

Mục tiêu của bài: Sử dụng các kiến thức đã được cung cấp về hệ màu, thao tác với 

vùng chọn để giải quyết bài toán hiệu chỉnh ảnh. Nắm vững các kỹ thuật phục hồi tình 

trạng ảnh.  

1. Màu cơ sở và các chế độ trộn màu 

Darkening (làm tối hình ảnh hoặc dùng để sửa những bức ảnh bị chói sáng) 

Lighting (làm sáng hình ảnh hoặc dùng để sửa những bức ảnh thiếu sáng) 

Contrasting (kết hợp cả Darkening và Lighting để hiệu chỉnh độ tương phản của bức 

hình) 

Compare – So sánh (để căn chỉnh và so sánh sự khác nhau giữa 2 bức hình) 

Coloring (để sửa sắc độ và độ bão hoà màu sắc) 

Hai chế độ hoà trộn đầu tiên (Normal và Dissolve) thì lại không nằm trong nhóm nào 

trong mấy nhóm trên cả. 

Normal: mặc định, chỉ đơn giản là layer này chồng lên cái kia, cái nào ở trên sẽ che lấp 

hết các pixel của các layer dưới. 

Dissolve: Chỉ hoạt động khi layer có những semi-transparent pixel (dịch nôm na là những 

pixel bán-trong-suốt), tức là những pixel đó vẫn có màu nhưng vẫn có thể nhìn xuyên qua 

những pixel đó. Semi-transparent pixel có được khi bạn xài brush với hardness <100% hoặc 

áp dụng bộ lọc blur hay set layer opacity dưới 100%. Để có thể hình dung rõ thì hãy xem hình 

bên dưới. 
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Hiệu ứng của Dissolve: 

 

 

2. Bảng chỉnh màu 
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3. Phục hồi trạng thái của ảnh. Các tuỳ chọn của phục hồi trạng thái hình ảnh 

History Brush Tool * ( Y ) 

Công cụ này dùng để Undo một phần của bức ảnh về trạng thái trước khi chỉnh sửa. 

Art History Brush Tool ( Y ) 

Art History Brush Tool cũng giúp undo một phần bức ảnh về trạng thái trước đó, nhưng 

sử dụng các nét vẽ kiểu cách điệu. 
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Bài 11. Sử dụng Palette Layer 

Mục tiêu của bài: Hiểu về lớp đối tượng, nắm vững cách tạo lớp và các thao tác cơ bản 

với lớp.  

1. Thao tác cơ bản với Palette Layer 

Layer (lớp) là một trong những tính năng mạnh mẽ và nổi bật nhất của 

Photoshop. Layer là những “lát hình ảnh” riêng lẻ có thể được xếp chồng lên nhau hoặc di 

chuyển để tạo nên bố cục hình ảnh của bạn.  

Bạn có thể vẽ, chỉnh sửa, dán và định vị lại các thành phần trên một layer này mà không 

làm ảnh hưởng đến các layer khác. 

Điều hướng và tổ chức các layer 

Việc tổ chức và điều hướng layer dễ dàng là điều rất quan trọng khi thiết kế trong phần 

mềm Photoshop. Phần này sẽ chỉ cho bạn cách chọn, di chuyển, tạo thư mục, tìm kiếm và sắp 

xếp các lớp. 

Chọn một layer 

Để thực hiện hầu hết các thao tác trong Photoshop, bạn sẽ cần phải chọn ít nhất một layer. 

Bạn chỉ cần nhấp vào một layer bất kỳ trong Layer Palette. Layer sẽ chuyển sang màu 

xanh [hiển thị bên phải], báo hiệu nó đã được chọn. 

Để chọn nhiều layer, nhấn và giữ phím CMD (Mac) hoặc CTRL (Windows) và nhấp vào 

từng layer bạn muốn chọn. Để chọn liên tiếp các layer, chọn layer đầu tiên>giữ phím SHIFT 

và chọn layer cuối cùng. 
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2. Các thành phần của Palette Layer 

Các bộ phận của một Layer 

Hiểu các phần của Layer sẽ giúp bạn hiểu rõ hơn về cách các Layer hoạt động và giúp 

bạn tận dụng được nhiều tính năng của các Layer.  

 

Layer Thumbnail 

Hiển thị nội dung của layer hiện tại 

Mẹo: Nhấn phím CMD (Mac) hoặc CTRL (Windows) và nhấp vào Thumbnail Layer để 

chọn tất cả nội dung của layer đó. 

Layer Mask 

Layer Mask giống như khuôn tô cho một layer. Mặt nạ layer sẽ che đi hoặc để lộ các 

phần nhất định của một layer. Các khu vực màu trắng trong mặt nạ được hiển thị trong khi các 

khu vực màu đen thì bị ẩn đi. 

Tạo mặt nạ mới bằng cách chọn một layer và sau đó nhấp vào biểu tượng (biểu tượng 

mặt nạ layer) ở cuối bảng layer. 

Chỉnh sửa mặt nạ bằng cách chọn Thumbnail của Layer Mask trong layer và sử dụng cọ 

vẽ để tô 

Mẹo: Nhấn phím CMD (Mac) hoặc CTRL (Windows) và nhấp vào hình thu nhỏ của mặt 

nạ để tạo một lựa chọn tất cả nội dung của mặt nạ đó. 

Thay đổi thuộc tính mặt nạ bằng cách vào Window và sau đó chọn Properties để hiển thị 

Bảng Properties. 

Tên layer 

Cho biết tên của layer đó. Theo mặc định, tên sẽ được xác định bởi loại layer. 

Đổi tên một layer bằng cách nhấp đúp vào tên layer, nhập tên mới và nhấn phím ENTER. 
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Liên kết layer và mặt nạ 

Biểu tượng liên kết này xuất hiện bất cứ khi nào bạn thêm Layer Mask vào một layer. 

Liên kết giúp đảm bảo rằng mọi thay đổi đối với layer đều được áp dụng cho mặt nạ layer. 

Liên kết hoặc hủy liên kết Mặt nạ layer bằng cách nhấp vào biểu tượng liên kết (Biểu 

tượng liên kết) trong layer. 

 

3. Lớp Background 

Background Layer  

Bất cứ khi nào bạn mở một hình ảnh trên Photoshop, layer mặc định chứa hình ảnh đó sẽ 

được gọi là Background Layer (Lớp nền). Background Layer là một layer được bảo vệ. Bởi 

thế, nhiều bộ lọc và hiệu ứng không thể áp dụng trên Background Layer. 

Để bỏ bảo vệ Background Layer: Bấm đúp vào tên layer trong Layers Palette, một hộp 

thoại sẽ xuất hiện để bạn có thể thay đổi tên layer và các chi tiết khác nếu bạn muốn, nhấp vào 

OK và giờ bạn có thể thoải mái tùy chỉnh background layer. 
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Bài 12. Sắp xếp các lớp 

Mục tiêu của bài: Nắm vững cách sắp xếp lớp, bố cục lớp và ảnh.  

1. Chọn và hiển thị hình ảnh của lớp trong danh sách 

Visibility Toggle (Tắt/bật layer) 

Đây là một tính năng tiện dụng cho phép hiển thị và ẩn các lớp cụ thể mà bạn không phải 

xóa chúng đi. 

Ẩn hoặc Hiển thị một layer bằng cách nhấp vào biểu tượng hình con mắt để chuyển đổi 

trạng thái hiển thị. 

 

2. Thay đổi thứ tự các lớp 

Như ta đã biết, thứ tự xếp các layer sẽ tạo nên sự khác biệt cho hình ảnh xuất hiện trên 

bản thiết kế. Do đó, ta cần biết cách di chuyển các layer để có thể thay đổi thứ tự của chúng 

khi cần thiết. 

- Chọn (các) layer ta muốn di chuyển. 

- Nhấp>giữ chuột và kéo layer đến vị trí mong muốn. Một line dày sẽ xuất hiện giữa 

các layer để chỉ thị chỗ mà layer sẽ được thả vào. Khi ta đã có layer mình cần, hãy 

thả chuột ra và layer sẽ di chuyển đến vị trí mới 
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3. Các tuỳ chọn của lớp 

Menu Layer: đây là nơi chứa các thao tác chỉnh sửa và làm việc với lớp đối tượng.  Menu 

Layer có rất nhiều menu phụ và các tùy chọn phức tạp. Ta có thể  xem lại phần 3 của loạt bài 

hướng dẫn này. 

 

- New: Các menu phụ trong menu này cho phép ta tạo ra  các lớp mới cũng như các 

tùy chọn để chuyển lớp hiện có thành lớp  Background (nếu cần). Ta cũng có thể 

nhóm các lớp đang chọn thành một  nhóm (việc lựa chọn nhiều lớp sử dụng Shift 

hoặc Ctrl – tương tự như  thao tác với các file trong thư mục). Tùy chọn này sẽ tạo 

ra các “thư  mục” lưu trữ những lớp đã được chọn để nhóm. 

- Duplicate Layer: Cho phép người dùng tạo một bản sao của lớp đang được chọn 

và lưu trữ nó vào đúng file đang mở hoặc tạo ra một file mới. 

- New Fill Layer/New Adjustment Layer:  Đây là cách tạo ra 2 loại lớp màu mới 

phủ lên trên lớp ảnh hiện tại.  Ta có thể tùy chỉnh 2 lớp mới tạo này một cách dễ 

dàng để tạo ra những  bức ảnh sống động. 

- Layer Mask/Vector Mask: Công cụ dùng để lọc hoặc ẩn  một phần (hay tất cả) các 

lớp đang hoạt động. Có sự khác biệt khá cơ bản  giữa hai loại Mask này đó là 

Mask theo vector và theo điểm ảnh. 
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- Clipping Mask: Đây là một tính năng khá khó hiểu, nó dùng để đặt một lớp hoặc 

nhóm lớp thành Mask để minh bạch cho lớp dưới nó. 

- Group Layers/Hide Layers: Nhiều lớp có thể được chọn trong panel Layers và 

được nhóm/ẩn trong menu này. 

 

- Align/Distribute: Công cụ này dùng để sắp xếp các  lớp trong không gian làm 

việc/không gian ảnh. Với công cụ này, ta có  thể căn đối tượng vào giữa ảnh hoặc 

chỉnh khoảng cách đều giữa các đối  tượng một cách dễ dàng. 

- Merge Down: Kết hợp các lớp hiện tại (hoặc nhóm lớp) với các lớp dưới nó. 

- Merge Visible/Flastten Image: Kết hợp tất cả các lớp  trong file của ta. Merge 

Visible sẽ bỏ qua tất cả các lớp ẩn trong  panel Layers, trong khi Flatten Image sẽ 

bỏ chúng đi hoàn toàn. Merge  Visible sẽ tạo ra các khoảng transparen ngoài 

những lớp ảnh đã kết hợp,  còn Flatten Image sẽ tạo ra một lớp Background theo 

màu mà ta định sẵn ở  Background color. 
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Bài 13. Sử dụng lớp tạo hiệu ứng trên ảnh 

Mục tiêu của bài: Nắm vững cách sử dụng lớp, các kỹ thuật thao tác với lớp và sử dụng 

chúng tạo các hiệu ứng với ảnh.  

1. Cách sử dụng các hiệu ứng lớp 

Để sử dụng Layer Style có hai cách 

 Cách thứ nhất: Bạn chuột phải vào Layer chọn Blending Options. 

 Cách thứ hai: Bạn chọn Layer xong ấn vào biểu tượng “fx” ở dưới Layer Panel. 

Sau khi chọn, hộp Layer Style hiện ra như hình dưới đây: 

 

Layer style option: 

Hộp Layer Style bao gồm ba phần chính 

 Danh sách các hiệu ứng: Các hiệu ứng đang được sử dụng sẽ dược tích chọn. 

 Thông số các hiệu ứng: Tương ứng với mỗi hiệu ứng sẽ hiện ra bảng thông số để bạn 

thiết lập. 

 Khung xem trước: Hiển thị hiệu ứng áp lên đối tượng trước ở đây. 

 

2. Công dụng các hiệu ứng lớp 

 Drop shadow: Tạo ra một cái bóng đắng sau nội dung Layer. 

 Inner shadow: Tạo ra một cái bóng đổ vào trong nội dung Layer. 

http://piodio.com/wp-content/uploads/2017/06/Layer-style-option-piodio.jpg
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 Outer Glow: Tạo ra một ánh sáng tỏa vào bên trong nội dung Layer. Có thể không thể 

xa như Drop shadow. 

 Inner Glow: Tạo ra một ánh sáng tỏa vào bên trong nội dung Layer. Một lân nữa, không 

thể xa như Drop shadow. 

 Bevel and Emboss: Được sử dụng để tao điểm nhấn và bóng hiệu ứng độc đáo trên một 

Layer. 

 Satin: Cung cấp cho các Layer hiệu ứng bóng như nước hoặc Plastic. 

 Color Overlay: Đổ màu cho Layer với 1 màu duy nhất. 

 Gradient Ovelay: Đổ màu cho Layer với Gradient. 

 Pattern overlay: Tạo chất liệu cho Layer. 

 Stroke: Tạo ra đường viền cho Layer. Có thể sử dụng một màu sắc, Gradient, hoặc chất 

liệu. 

 

3. Biên tập một hiệu ứng lớp riêng 

Gloss contour 

 Tạo ra những vệt bóng hay kim loại. 

 Thường được sử dụng cho những cạnh của Bevel and Emboss. 

Gradient 

Áp tô màu chuyển sắc cho hình, cách sử dụng giống công cụ Gradient. 

Highlight or Shadow mode 

Tạo chế độ hòa trộn của Bevel and Emboss là vùng sáng hay vùng tối. 

Jilter 

Thay đổi cấc ứng dụng màu và Opacity của Gradient. 

Layer knocks out drop shadow 

Kiểm soát các độ đổ bóng của những Layer gần như trong suốt. 

Noise 

 Chỉ định một số ngẫu nhiên cho độ mờ đục của ánh sáng hay bóng tối. 

 Nhập thông số hoặc kéo thanh trượt để tùy chỉnh 

Opacity 
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Độ mờ đục của hiệu ứng, có thể nhập thông số hoặc kéo thanh trượt. 

 

 

4. Tạo bóng các đối tượng trên ảnh 

Tạo đổ bóng bên dưới Layer 

 

 

 
  

http://piodio.com/wp-content/uploads/2017/06/Drop-shadow-style-photoshop-piodio.jpg
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Bài 14. Sử dụng mặt nạ lớp 

Mục tiêu của bài: Nắm vững cách sử dụng mặt nạ lớp nhằm tạo các hiệu ứng với ảnh.  

1. Tạo mặt nạ lớp 

Layer mask (mặt nạ lớp): 

Mặt nạ sử dụng để che một phần của hình ảnh mà vẫn bảo toàn ảnh gốc. Mặt nạ chỉ sử 

dụng hai màu (của ô màu foreground): 

 Trắng (hiển thị) 

 Đen (che) 

Thao tác: 

 Chọn layer ảnh muốn tạo mặt nạ che 

 Click biểu tượng (Add a Layer Mask) ở phía dưới Palette Layer sử dụng một trong 

các công cụ để che mặt nạ (công cụ Brush với đầu cọ mềm hoặc công cụ Gradient,…) 

 

2. Chỉnh sửa mặt nạ 

 Chọn Layer muốn tạo mặt nạ che 

 Menu Layer\ Add Layer Mask\ 

 Reveal All: Hiển thị tất cả 

 Hide All: Che tất cả 

 Reveal selection: Hiển thị phần bên trong vùng chọn 

 Hide selection: Che phần bên trong vùng chọn 

 Mở tập tin 

 Import > Copy ảnh lên layer 2 

 Layer trên > Add layer mask 

 Dùng công cụ tô chuyển sắc vẽ chuyển sắc 

 Được kết quả 

 

3. Phối hợp thao tác vùng và mặt nạ 

Ví dụ minh họa 
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 Hai ảnh ghép vào nhau sử dùng mặt nạ lớp (Layers mask) 

 

Bấm chọn biểu tượng Add Layer mask để ghép hai ảnh lại 

 

 Sau khi ghép bằng mặt nạ lớp (Layer mask) 
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4. Sử dụng Channels 

Tạo Kênh Alpha 

Sẽ là hữu ích nếu bạn nghĩ đến kênh alpha dưới dạng biểu tượng màu xám của lựa chọn 

của bạn. Trừ khi bạn thay đổi cài đặt của Photoshop, các phần màu đen của kênh là phần không 

được chọn của hình ảnh của bạn - còn được gọi là phần được bảo vệ hoặc che dấu - và các 

phần trắng là vùng chọn. Và, giống như trong mặt nạ lớp, màu xám đại diện cho các khu vực 

chỉ được chọn một phần, có nghĩa là chúng đều trong suốt. 

Photoshop cung cấp cho bạn một số cách khác nhau để tạo một kênh alpha: 

Tạo một vùng lựa chọn và sau đó chọn Select > Save Selection. Tạo một lựa chọn và sau 

đó nhấp vào nút "Lưu lựa chọn làm kênh" ở cuối bảng Kênh . Nó trông giống như một vòng 

tròn trong một hình vuông. Nhấp vào nút "Tạo kênh mới" ở cuối bảng Kênh . Khi bạn thực 

hiện điều đó, Photoshop tạo một kênh alpha có tên là Alpha 1và gậy nó ở 

cuối bảng Channels . Kênh mới là màu đen đậm vì nó trống rỗng. Để tạo vùng lựa chọn, hãy 

bật khả năng hiển thị của kênh tổng hợp để triệu tập lớp phủ màu đỏ của chế độ Quick Mask để 

bạn có thể xem hình ảnh của mình. Sau đó lấy công cụ Brush(B) và vẽ vùng bạn muốn chọn 

màu trắng (nghĩ về quá trình này như vẽ một lỗ thông qua mặt nạ để bạn có thể nhìn thấy-và 

do đó chọn-những gì bên dưới nó). Mặc dù bạn chắc chắn có thể bắt đầu bằng một kênh alpha 

rỗng, bạn sẽ dễ dàng tạo ra lựa chọn của bạn (hoặc ít nhất là một phiên bản thô) trên hình ảnh 

đầy đủ màu trước khi thêm kênh alpha. Trong hầu hết các trường hợp, bạn sẽ thấy dễ dàng hơn 

để tạo một lựa chọn đầu tiên (ngay cả khi nó thô) và sau đó thêm kênh alpha của bạn, như thể 

hiện thổi. (Bằng cách đó, bạn sẽ thấy hình ảnh đầy màu thay vì màn hình đầy màu đen hoặc 

đỏ) Để làm điều đó, hãy chọn một cái gì đó trong hình ảnh của bạn, sau đó, khi bạn đã có kiến 

diễu hành, nhấp vào "Lưu lựa chọn làm kênh" nút (vòng tròn bên dưới). Photoshop bổ sung 

một kênh alpha - bao gồm lựa chọn của bạn - xuống dưới cùng của bảng Kênh . 

 

Chọn Kênh Mới từ trình đơn của bảng Kênh . Khi bạn chọn lệnh này, một hộp thoại mở 

ra cho phép bạn đặt tên kênh mới và cho Photoshop cách hiển thị thông tin của kênh. Ngay từ 

nhà máy, Photoshop hiển thị các khu vực được lựa chọn (các phần của hình ảnh của bạn bên 

trong những con kiến diễu hành) ở các khu vực trắng và không được chọn trong màu đen. Khu 

https://psdbox.com/wp-content/uploads/2016/03/1.jpg
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vực được lựa chọn một phần, có cạnh mềm, xuất hiện trong các sắc thái của màu xám. Nếu 

bạn muốn xem các lựa chọn của bạn bằng màu đen và mọi thứ khác bằng màu trắng, hãy 

bật nút radio Chọn vùng của hộp thoại . Nếu bạn muốn chỉnh sửa kênh alpha bằng chế 

độ Quick Mask (như được mô tả ở phần sau), bạn có thể thay đổi Quick Mask'smàu sắc và độ 

mờ đục ở đây. Khi bạn đã có mọi thứ theo cách bạn muốn, hãy nhấp vào OK để tạo cho 

Photoshop tạo kênh alpha của bạn. 

Chỉnh sửa Kênh Alpha 

Một khi bạn đã có một kênh alpha, bạn có thể tinh chỉnh nó giống như một mặt nạ lớp 

bằng cách vẽ bằng công cụ Brush hoặc sử dụng bất kỳ công cụ lựa chọn nào. Nếu bạn sử dụng 

công cụ chọn, bạn có thể chọn Chỉnh sửa > Điền và sau đó chọn màu đen hoặc trắng từ trình 

đơn bật lên sử dụng, tùy thuộc vào việc bạn muốn thêm vào hoặc trừ đi từ lựa chọn của bạn 

(các vùng được chọn là màu trắng và mọi thứ khác là đen). 

Nếu bạn muốn đảo ngược cách Photoshop hiển thị thông tin của kênh - để lựa chọn của 

bạn xuất hiện bằng màu đen thay vì trắng - chỉ cần nhấp đúp vào hình thu nhỏ của kênh alpha 

trong bảng Kênh và, trong hộp thoại Tùy chọn Kênh Kết quả , hãy bật nút Đã chọn Khu 

vực tùy chọn. Khi bạn làm như vậy, Photoshop lật mặt nạ của bạn, như thể hiện dưới đây. 

Nhấn đúp vào hình thu nhỏ của kênh alpha trong bảng Kênh sẽ hiển thị hộp thoại hiển thị 

dưới đây, cho phép bạn nói với Photoshop để đảo ngược màu mặt nạ (màu đen). Bạn cũng có 

thể sử dụng hộp thoại này để biến kênh alpha thành màu spot hoặc để thay đổi màu sắc và độ 

mờ của lớp phủ Quick Mask . Để thực hiện thao tác sau, nhấp vào mẫu màu đỏ, chọn một màu 

mới từ Bộ chọn Màu Kết quả , sau đó nhấp vào OK . 

 

Bạn cũng có thể chỉnh sửa kênh alpha bằng chế độ Quick Mask . Để làm điều đó, 

trong bảng Kênh , kích hoạt kênh alpha và sau đó nhấp vào mắt nhìn của kênh hỗn hợp, như 

được hiển thị bên dưới. Khi bạn làm như vậy, Photoshop đặt chế độ che dấu chữ màu đỏ của 

chế độ Quick Mask trên đỉnh hình ảnh của bạn. (Nếu bạn đang chỉnh sửa kênh alpha trong một 

hình ảnh có nhiều màu đỏ, bạn sẽ không thể nhìn thấy rõ qua mặt nạ, do đó hãy thay đổi màu 

lớp phủ như mô tả ở trên). 

https://psdbox.com/wp-content/uploads/2016/03/2.jpg
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Nếu bạn kích hoạt một kênh alpha và sau đó bật mắt nhìn của ống composite (hình tròn 

bên dưới), bạn có thể chỉnh sửa hoặc tạo vùng lựa chọn từ đầu trong chế độ Quick 

Mask . Trong ví dụ này, công cụ Brush (vòng tròn màu trắng bên dưới váy đầm) được thiết lập 

để vẽ bằng màu đen đang được sử dụng để điều chỉnh vùng mặt nạ xung quanh trang phục cô 

gái. Nếu bạn lộn xộn và che dấu quá nhiều - bằng cách sơn màu đen qua một phần của trang 

phục, do đó trừ nó khỏi vùng lựa chọn của bạn, hãy nhấn-X để lật các mẩu màu của bạn và sơn 

qua vùng đó bằng màu trắng để thêm nó vào lựa chọn (giống như bạn sẽ với một lớp mặt nạ). 

 

Bạn cũng có thể chạy bộ lọc trên kênh alpha giống như bạn có thể với mặt nạ lớp. Trong 

số những tính năng hữu ích nhất là Gaussian Blur để làm mềm cạnh của vùng lựa chọn (hữu 

ích nếu bạn đang cố chọn một khu vực hơi mờ) và bộ lọc Tối thiểu để thắt chặt sự lựa chọn 

của bạn. 

 

 
  

https://psdbox.com/wp-content/uploads/2013/07/3.jpg
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Bài 15. Tạo và sử dụng đường trong ảnh 

Mục tiêu của bài:  Nắm vững ý nghĩa, công dụng và cách tạo đường trong ảnh 

1. Điểm neo, đường định hướng, điểm hướng và các thông số 

Path bao gồm một hoặc nhiều đường thẳng và cong. Anchor Point đánh dấu những điểm 

kết thúc của Path. Ở vùng path cong, mỗi một điểm Anchor point được chọn hiển thị một hoặc 

hai đường định hướng, kết thúc ở điểm định hướng. Vị trí của đường định hướng và Point xác 

định kích thước và hình dạng của những vùng Path cong. Di chuyển những thành phần này sẽ 

định dạng lại những đường cong của Path. Một path có thể là path đóng mà không có cả điểm 

đầu và kết thúc ví dụ như hình tròn, hoặc là Path mở với điểm đầu và điểm kết thúc không 

trùng nhau ví dụ là đường gợn sóng. 

Một đường cong mềm mại được nối với nhau bởi những điểm Anchor Point và gọi là 

những Smooth Point. Những đường cong sắc nhọn được nối với nhau bởi những Corner Point. 

Khi bạn di chuyển đường định hướng trên một Smooth Point, vùng cong ở hai bên của điểm 

đó tự đồng điều chỉnh đồng thời. Ngược lại, khi bạn di chuyển đường định hướng trên một 

Corner Point, chỉ duy nhất vùng con ở trên cùng một bên của điểm tại đúng vị trí đường định 

hướng được điều chỉnh. 

Một path không nhất thiết phải là một loạt những phần nhỏ nối tiếp với nhau. Nó có thể 

bao gồm nhiều hơn một những thành phần Path riêng lẻ. Mỗi hình dạng trong Shape Layer là 

một thành phần của path, được miêu tả là Clipping Path của layer. 

2. Các công cụ tạo và hiệu chỉnh đường 

Pen Tool * ( P ) 

Công cụ Pen Tool dùng để vẽ các đường path cực kỳ chính xác dưới dạng vector hoặc 

các vùng lựa chọn. 

Freeform Pen Tool ( P ) 

Công cụ Freeform Pen để vẽ các đường path hoặc hình shape dạng tự do. Điểm neo được 

tự động thêm vào đường dẫn khi bạn vẽ. 

Add Anchor Point Tool 

Thêm điểm neo vào path hoặc shape 

Delete Anchor Point Tool 
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Công cụ xoá điểm nối, hay điểm neo (Anchor Point). 

Convert Point Tool 

Công cụ chuyển đổi điểm neo, giúp làm mượt hoặc chỉnh sửa các góc bo khi dùng 

Pentool. 

3. Sử dụng công cụ Pen 

 

Ở thanh công cụ của Photoshop, bạn tìm đến Pen Tool, click và giữ chuột trái vào công 

cụ này để mở ra các công cụ phụ khác kèm theo Pen Tool. Với những phiên bản Photoshop 

mới bạn sẽ thấy có tới 5 công cụ trong bảng này, nhưng về cơ bản bạn chỉ có 4 công cụ chính. 

  

Bước 1: Chọn Pen Tool, Click 1 điểm tại điểm bắt đầu của đường cong, chỉ Click rồi thả 

ra không kéo hay di chuyển gì.  

Bước 2: tiếp tục Click vào điểm cuối của đường cong, cũng vẫn chỉ Click rồi nhả ra không 

di chuyển gì.  
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Bước 3: Di chuột đến giữa đoạn Path nối 2 điểm, Click 1 lần nữa, lúc này 2 tay quay của 

điểm giữa sẽ tự hiện lên.  

Bước 4: Giữ Ctrl để Pen Tool chuyển sang Direct Selection Tool, chọn điểm chính giữa 

và kéo lên để tạo ra đường cong.  

Bước 5: Để điều chỉnh đường cong này, bạn có thể giữ Ctrl và kéo tay quay của điểm neo 

chính giữa đường Path.  

Bước 6: Làm tương tự các bước trên với điểm bắt đầu là điểm kết thúc của đường cong 

trên để tạo ra đường Path như hình. 

4. Sử dụng FreeFrom Pen 

  

Bước 1: Click 1 điểm neo rồi kéo về hướng muốn tạo đường cong, bạn sẽ thấy 2 đầu tay 

quay của điểm này.  

Bước 2: Click vào điểm cuối của đường cong và cũng nhớ kéo đi tạo tay quay cho điểm 

này, điều chỉnh đường cong phù hợp trước khi nhả chuột trái ra.  

Bước 3: Giữ phím Alt và Click vào điểm cuối của đường cong để cắt bỏ phần tay quay 

không sử dụng, khi cắt đi, phần Path phía trước sẽ không bị ảnh hưởng gì khi bạn vẽ phần tiếp 

theo.  

Bước 4: Tiếp tục các bước như trên cho tới khi khép kín đường Path, bạn đã tạo được 1 

đường Path với hình thù phức tạp. 
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Bài 16. Sử dụng Palette Path 

Mục tiêu của bài: Sử dụng thành thạo Palette Path để tạo đường 

1. Hiệu chỉnh đường cong 

Bước 1: Tạo Layer mới trong Photoshop 

Nhấn tổ hợp 3 phím Ctrl + Shift + N. 

Bước 2: Chọn công cụ Pen Tool và kiểu vẽ Path 

Lưu ý: Trong các phiên bản Photoshop mới hơn, bạn có thể nhấp vào biểu tượng hình 

bánh răng để bật "Rubber Banding". Điều này cho phép bạn xem trước dòng của bạn khi bạn 

vẽ nó, thường hữu ích cho người mới bắt đầu. 

Bước 3: Tạo đường thẳng 

Giữ phím Shift, rồi nhấn chọn điểm đầu và điểm cuối của đường thẳng. 

Bước 4: Vẽ đường cong 

Chọn công cụ Add anchor point tool tại điểm vừa chọn Pen Tool. 

Tiếp theo, chấm chọn điểm cần phải làm đường cong trên đường thẳng vừa tạo ra. Sử 

dụng tổ hợp phím Ctrl và kéo lên trên/ xuống dưới để tạo đường cong như mong muốn. Bạn 

có thể tạo ra 2, 3 hoặc nhiều điểm cong lên cong xuống tùy ý.  

Bước 5: Chỉnh sửa đường cong 

Để chỉnh sửa đường cong, sau khi tạo điểm bằng Add anchor point tool, bạn cần kéo tới 

vị trí thích hợp để tìm đường thẳng với 2 hình tròn 2 bên điểm đó. Giữ Alt và kéo lên kéo 

xuống để thay đổi độ cong của từng bên theo ý bạn. 

Bước 6: Tô màu đường cong 

Chọn Bursh Tool, mở cửa sổ mới và thiết lập Bursh theo ý muốn (chọn kích cỡ và kiểu 

cọ vẽ). 

Chọn Pen Tool, nhấn chuột phải vào đường vừa vẽ và chọn Stroke Path. 

2. Hiệu chỉnh điểm neo 

Chọn điểm neo 

Chọn công cụ Direct Selection và nhấp vào đường dẫn để xem các điểm neo của nó. Nhấp 

vào một điểm để chọn nó. Nhấn phím Shift và nhấp để thêm hoặc xóa các điểm khỏi vùng 

chọn hoặc kéo qua các điểm neo để chọn chúng. 

Công cụ Direct Selection 
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Bạn có thể chọn công cụ Direct Selection bằng cách nhấn phím “A” hoặc công 

cụ Selection bằng cách nhấn phím “V”. 

Thêm và xóa các điểm neo 

Bạn có thể thêm điểm vào đường dẫn đã chọn bằng cách nhấp vào đường dẫn bằng công 

cụ Pen tool (P). Để loại bỏ các điểm neo, bấm trực tiếp vào một điểm neo. 

Chỉnh sửa điểm neo trong khi vẽ bằng công cụ Pen tool 

Để chọn và di chuyển các điểm neo bằng công cụ Pen tool nhấn phím Command (MacOS) 

hoặc phím Ctrl (Windows) để tạm thời chọn công cụ Direct Selection. Sau đó kéo các điểm 

neo bạn chọn. 

3. Paths Palette 

Các Palette có các tính năng Photoshop mà bạn có thể cần truy cập thường xuyên. Không 

phải lúc nào bạn cũng cần có các Palette hiển thị. Trong Photoshop CS6, bấm phím Tab để che 

giấu tất cả các Palette hoặc bấm Shift+Tab để che dấu cả ngoại trừ Toolbox và thanh Options. 

càng ít Palette hiển thị hơn, Palette bạn có thể tạo nhiều chỗ hơn cho ảnh của bạn. Ngoài ra, 

Bạn có thể che giấu và hiển thị các Palette một cách có chọn lọc thông qua menu Windows. 

 

Như bạn thấy ở hình trên nhiều Palette có thể được xếp lồng (được nhóm lại với nhau). 

Để đưa một Palette ra phía trước, hãy nhấp vào tab của nó. Bạn cũng có thể rê tab của một 

Palette để di chuyển nó khỏi một nhóm đến một vị trí bất kỳ trên màn hình hoặc vào một nhóm 

khác. Ngoài ra, ở cuối bên phải của thanh Options là Palette Well. Theo mặc định Palette Well 

này chứa các Palette Brushes, Tool Pre-sets, và Layer Comp. Hãy rê tab của một Palette vào 

Palette Well để đưa nó ra theo cách của bạn nhưng vẫn giữ cho nó dễ truy cập. 

 
  

http://1.bp.blogspot.com/-TRZPr9lvjGU/VOM_pg-45pI/AAAAAAAAAIA/tbH1qDzs73Q/s1600/palette-trong-photoshop-cs6.jpg
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Bài 17. Chuyển đổi hệ màu 

Mục tiêu của bài: Nắm vững các mô hình màu, chuyển đổi các hệ màu, sử dụng hệ 

màu một cách hợp lý.  

1. Các mô hình màu 

Mô hình màu cộng (additive color model) 

Màu cộng là nền tảng của mọi màu sắc, vì bắt nguồn từ nguyên lý cảm nhận màu của 

mắt. Võng mạc trong đáy mắt người có những tế bào hình nón nhạy cảm với các màu đỏ (red), 

lục (green) và lam (blue). Các tế bào này truyền tín hiệu riêng lẻ đến não bộ, ở đó hình ảnh 

được tổng hợp thành tất cả màu sắc. Ngoài ra còn có tế bào hình que nhạy cảm với các sắc độ 

sáng tối của màu sắc. 

 

Chúng ta cảm nhận được màu sắc nhờ ánh sáng phản chiếu từ vật thể và đi đến mắt của 

chúng ta. 

Nguời ta gọi mô hình màu cộng là mô hình RGB. Nguyên lý này được ứng dụng trong 

công nghệ chế tạo màn hình tivi, màn hình máy vi tính, kỹ thuật video, chiếu sáng… 
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Mô hình màu trừ (subtractive color model) 

Mô hình màu cộng bắt đầu từ màu đen (một màn hình tivi trống và cộng màu R, G, B để 

có được màu trắng). Ngược lại mô hình màu trừ bắt đầu với màu trắng (một tờ giấy trắng được 

chiếu bằng ánh sáng trắng và trừ đi màu R,G, B của ánh sáng trắng để có được màu đen). 

Việc loại bỏ ánh sáng R, G, B được thực hiện bằng việc in chồng các màu mực lam - lục 

(cyan), đỏ cánh sen (magenta) và vàng (yellow). Mực Cyan có tác dụng hấp thu ánh sáng red, 

mực Magenta hấp thu ánh sáng green, mực Yellow hấp thu ánh sáng blue. 

 

Mực Cyan hấp thu ánh sáng đỏ - mực Magenta hấp thu ánh sáng lục - mực Yellow hấp 

thu ánh sáng lam 

Bất kỳ màu nào trong khoảng màu phục chế (CMYK gamut) được đều có thể đạt được 

bằng cách thay đổi tỷ lệ mực màu C, M, Y. Mô hình màu trừ được sử dụng cho kỹ thuật nhiếp 

ảnh màu hiện đại và trong tất cả các quá trình in màu công nghiệp. Trên thực tế do mực in 

không tinh khiết nên khi 3 màu C, M, Y chồng lên nhau vẫn không tạo ra được màu đen thật 

sự. Và ngành in phải dùng thêm một bản in với mực đen để bổ trợ cho C, M, Y để tạo thêm 

chi tiết và chiều sâu cho hình ảnh. 

 
Trong ngành in, 4 màu CMYK được gọi là 4 màu process colors 
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2. Chế độ màu trong phần mềm xử lý ảnh 

RGB Color: Chế độ ảnh tổng hợp 3 màu chuẩn RGB, Đỏ (R) Xanh lá cây (G) và Xanh 

da trời (B). RGB là không gian màu dương tính thường được sử dụng phổ biến vì nó rất thuận 

lợi trong việc chỉnh sửa. 

CMYK Color: Chế độ ảnh tổng hợp 4 màu chuẩn. Là sự phối hợp giữa Cyan (da trời) 

Magenta (tím) Yellow (vàng) và blacK (đen). CMYK là không gian màu âm tính thường được 

sử dụng trong Lap in ấn. 

Lab Color: Chỉnh ảnh theo phương thức chụp, là không gian màu độc lập và chỉnh sửa 

màu trong hệ màu trền kềnh a hoặc kềnh b cũng như tạo ra những thay đổi mạnh mẽ nhất về 

màu sắc. Lab là hệ màu rất thích hợp trong chỉnh sửa ảnh KTS. 

3. Chuyển đổi hệ màu 

 
Nhóm chế độ màu chuyển đổi Mode trong Menu Image 
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Bài 18. Chuyển đổi ảnh xám và phân mức ảnh 

Mục tiêu của bài: Nắm vững các mô hình ảnh xám, mức xám, ý nghĩa và kỹ thuật của 

việc phân ngưỡng.  

1. Chuyển từ ảnh màu sang ảnh xám (grayscale) 

Khi mở file ảnh cần chỉnh sửa, vào Menu Image chọn Mode bạn sẽ thấy các chế độ màu 

tổng hợp như sau (các dạng thường sử dụng): 

GrayScale: Chuyển ảnh sang màu trắng đen. 

Phương pháp chuyển đổi màu đen trắng đơn giản nhất, chuyển thành màu xám để loại bỏ 

tất cả thông tin màu trong một bức ảnh. 

 Image > Mode > Grayscale 

 Nhấp chuột vào ‘Discard’ 

Phương pháp này sử dụng giống nhau cho cả Photoshop và Elements. 

 Ưu điểm: Nhanh chóng và dễ dàng. 

 Nhược điểm: Bạn không có quyền kiểm soát sự chuyển đổi. 

2. Chuyển ảnh duotone 

Đây là cách để làm điều đó. Trước tiên, chuyển ảnh của bạn sang màu đen và trắng. Bạn 

không cần phải điều chỉnh cài đặt màu đen và trắng. Nó dễ dàng hơn để làm điều đó sau khi 

phân loại màu sắc. 

 

Tiếp theo, đi đến Tone Curves. Nếu bạn không hiểu những gì đường cong giai điệu, bạn 

vẫn có thể làm theo mà không có bất kỳ vấn đề. Nếu bạn tìm hiểu thêm, hãy kiểm tra video 

của tôi về cách sử dụng đường cong giai điệu . Nhưng để giúp bạn có được, tôi sẽ đặt một số 
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lớp phủ trong video này để bạn có thể cảm nhận được điều gì đang xảy ra khi chúng tôi thực 

hiện các điều chỉnh. 

 

3. Chuyển ảnh bitmap 

Theo khái niệm thiết kế đồ họa, bitmap là ảnh có dạng mảnh hóa (Rater Image). Nghĩa 

là ảnh tạo từ các điểm ảnh (pixel). Các điểm ảnh sẽ sắp xếp theo lưới và chứa thông số màu 

nhất định tạo thành ảnh bitmap. 

 

Ảnh bitmap khi được phóng to trong photoshop 

Có thể nói, chúng là ma trận 2 chiều của các điểm ảnh. 

Ví dụ: khi đưa hình ảnh bitmap vào photoshop và phóng to. Bạn sẽ thấy khi phóng càng 

lớn, ảnh càng bị bể. Do đó, khi thao tác trên hình ảnh đồng nghĩa người dùng sẽ thao tác từng 

điểm ảnh trên đó. Vì vậy, những người xử lý ảnh bitmap thường có kiến thức về chỉnh sửa 

điểm ảnh. 

Các loại ảnh bitmap: thường có trên mạng, thiết bị androi, iOS hoặc phần mềm lập trình 

như: c#, c++ 
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4. Lựa chọn ngưỡng 

Các Adjustment Layers trong Photoshop là một nhóm các công cụ chỉnh sửa hình ảnh 

cực kỳ hữu ích, không phá hoại mà thêm màu sắc và các điều chỉnh âm thanh cho hình ảnh của 

bạn mà không thay đổi vĩnh viễn các điểm ảnh của nó. 

Với các Adjustment Layers, bạn có thể chỉnh sửa và loại bỏ các điều chỉnh của bạn hoặc 

khôi phục lại hình ảnh ban đầu bất cứ lúc nào. Điều này sẽ làm cho công việc của bạn trong 

Photoshop linh hoạt hơn và hiệu quả hơn, và là một tuyệt đối phải biết. 

Đối với hướng dẫn này, chúng ta sẽ đi qua các vấn đề cơ bản của từng loại Adjustment 

Layers, làm việc với cài đặt mặc định của chúng trong CS6. 

 

Khi bạn thêm Adjustment Layers vào hình ảnh của mình, một lớp mới sẽ xuất hiện trên 

hình ảnh của bạn và một bảng điều khiển thuộc tính đặc trưng cho loại điều chỉnh bạn đã chọn 

sẽ xuất hiện. Bảng điều khiển thuộc tính sẽ cho phép bạn sửa đổi Adjustment Layers của bạn, 

từ đó sẽ sửa đổi hình ảnh của bạn. 

Brightness/Contrast 
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 Brightness/Contrast (Độ sáng / Độ tương phản) làm cho điều chỉnh phạm vi màu sắc của 

hình ảnh của bạn. Thanh trượt độ sáng là để điều chỉnh các điểm nổi bật trong hình ảnh của 

bạn và thanh trượt Phóng to để điều chỉnh bóng trong hình ảnh của bạn. 

Levels 
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Levels sửa đổi các giá trị âm thanh trong một hình ảnh bằng cách điều chỉnh các mức độ 

của bóng, midtones, và nổi bật. Đây là một trong những công cụ được sử dụng nhiều nhất trong 

bảng điều chỉnh lớp và chỉ cần sử dụng một mức độ sẽ giúp bạn chỉnh sửa hình ảnh của mình 

một cách lâu dài. 

Curves 

 

 

 

 

 

 

  



Trang 73 

 

TÀI LIỆU THAM KHẢO 

- Nguyễn Minh Đức, Căn bản về Photoshop CS tinh chỉnh và xử lý màu, NXBGTVT 

- Nguyễn Phương, Photoshop CS 8. 0, NXBTN, 2004.  

- VN Guide, Adobe Photoshop, NXBTK, 2003. 


